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1. Introduction to 3DMath Explorer 
3DMath Explorer is a tool for piloting mathematical curves. It has many new features different from traditional mathematic piloting programs. Fist of all 3DMath Explorer use 3 dimensional math. space instead of 2 dimensional plane to draw any kind of graph. It is a computer program that pilots 2D and 3D graphs of mathematical functions and curves in an unlimited graphing space. 
Its use spectrum changes from teaching of secondary and high school students to collage and university students and from engineering and academicals works to architecture and many other technical fields.    

3DMath Explorer is a very useful program for students to make experiment and observation, for teachers to teach the subjects more interesting and comfortable, for writers to select graphs for their books within more suitable, beautiful and comprehensible graphs, and for all people that interests in this subject to use with ease. 

It has many useful feature such as perspective drawing, graph scaling (zooming), fogging effect, drawing many curves in the same screen, working with many graph screens in the same time, est.  

Beyond its great graphics, it has very user friendly graphical user interface. So it is easy to use to work with.

2. Features of 3DMath Explorer
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Technical features of 3DMath Explorer

1. It uses an object driven graphical space model. So all properties (like draw type, pen withy, sampling period, colors est.) of objects existed in this graphical space can be change by user.
2. It draws all kind of mathematical curves in the same 3D piloting system.

3. There are x, y and z axis’s, xy, xz, and yz grids, est. found as pilot element in unlimited graphing space.
4. It draws graphs with perspective view that draws near lines, points est. with their true length and draws far ones length a little lessened depends on their distance.
5. It has many useful special features like rotating or scaling graph (zooming).
6. You can actively (only with mouse movements) rotate graphs to position where ever you want to look at and get a view of it.
7. It compiles the functions given by users as parameters of curves, calculates sample coordinates of vertexes that belongs to curves, and draws them in an unlimited object driven graphical space with separate points or joined lines and polygons.

8. It can pilot more than one curve in the same window.

9. User can view front, left, top and perspective view of the graph at the same time. 

10. It use a useful fogging effect depends on physical distance of elements to fog the graph.

11. It can cover 2D and 3D curves and objects with polygons.

12. For 3DMath Explorer, one click is enough to animate the graph. Any animation direction could select with a short mouse movement.
13. User can opens many sample curve files with ‘.tec’ extension, change or redefine them and save them as their own curves. They can easily define new curves of their own by using option of select a template curve to define a new curve. 
14. Program has a quality that all users like to use. Because it is so user friendly that they can do every thing without opening a single menu. Every thing can be easily done by using toolbars and mouse.
15. It built on not only engineering knowledge and experiences but also mathematical knowledge and experience (or just opposite). So it is much more suitable piloting program for mathematical way of thinking.

3. What’s New in This Version 3.1?
With this new version of 3DMath Explorer, 
1. Same reported problems corrected.
2. Included 9 new mathematical functions (sech, cosech, arcsec, arccosec, arcsech, arccosech, heav, zero and ph). 

3. Template curve database carried into a simple text file. So program does not need a database engine any more. 
4. Its setup disk size lessened to 2.6 MB. So user can easily download it over internet.
5. Much more sample curve included to the program. Users can open them as ‘.tec’ extension file or select them from template curve file (‘CurvedLines.txt’)
On the other hand this version carries out 3 novelties more important than all others. They are;
a. Fogging: The components colors in the graph opens towards to background color depending on distance to look point. Our aim is to blur the far element of graph. That gives the graph fogging effect. As a result of this we call this property fogging. Fogging density could change from pilot screen properties form too.

b. Polygon Draw: With this version 2D and 3D curves could cover with polygons. This new property gives these curves surface area and volume. 

c. Perspective Horizon Point: The program draws graphs with perspective view that draws near lines, points est. with their true length and draws far ones length a little lessened depends on their distance. Perspective horizon point defines the far point that user can see in the screen. This point determines the effects of perspective property on to the screen.  In this version user can change this point from pilot screen properties form
4. Piloting Curves with 3DMath Explorer
It is very easy work to pilot mathematical graphs with 3DMath Explorer. Two basic tools are used for piloting. They are Curve Explorer and Pilot Windows/Screen. Curve Explorer is a tool that lets you see and change all properties of curves of active graph screen. On the other hand Pilot Screen is a window which opens to space that mathematical curves get life or it is projection of 3D vision that formed in this space and reflected on to 2D computer screen.
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Pilot Screens with their modifiable properties like curves that draws in them gives users ability to change all properties of it. You can change display properties of all pilot elements that exist in pilot screen. You can change pen and brush color of axis’s and grids, or change perspective and fogging effect on and off. You can also change fogging density and horizon point distance of perspective or open four view screen to see front, right, top and perspective view of the graph in the same screen. You can rotate graph over x and y axis’s, and zoom the graph to get any size of it.    
With Curve Explorer, you can move over curves that exist in Pilot Screen one by one, and change their properties. You can add a new curve or delete existed curves. You can add them to template curves or transfer them to another pilot screen. If you want to quickly define e new curve, you can select a template curve or transfer a curve from another pilot screen. But do not forget, you have to press Apply button to apply any changes on to the pilot screen.

Now let’s study what views you can get with 3DMath Explorer. To do this we will examine a curve that defined as;
0 ≤ a ≤ Pi      , a(step)=Pi/20, 

0 ≤ b ≤ 2*Pi  , b(step)=Pi/20 
fx(a,b) = 5*sin(b)*(0,5+sin(a))
fy(a,b) = cos(6*a)/2 
fz(a,b) = 5*cos(b)*(0,5+sin(a))
In the below you see the curve with properties Pen Color =Teal, Draw Type=Lines, sampling period=Pi/20, Pen Width=2. I named it ‘firizbi’ (is a Turkish word, mains a toy that people play with in the park, dogs likes the game very much. I don’t now its English name.)
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In the below you see the same curve with its four view, XY-grid and YZ-grid are off and draw type is points. Its background color chose as silver too.
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You see the same curve with its Draw Type=Polygon and Brush Color=Yellow in the screen that have %100 fogging density. In this screen/window you also see the YZ-Grit set visible with Draw Type=Polygon.
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As you see, you can easily draw unlimited number of curves that suits your good testes with 3DMath Explorer by changing all properties of curves and pilot screen 
5.1. Other Forms and Tools
5.2. Template Curve Selection or Template Curve Entry
The easiest method to enter e new curve into a pilot screen with curve explorer is selecting a template curve from template curves by using Template Curve Selection form that opens with Select button on the Curve Explorer. In this form, you can select a template curve by double click on the grit or pressing OK button. 

You can see active template curve in preview screen. You can easily change properties of this screen with aid of buttons and other subjects.
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In Template Curve Selection form you can enter a new template curve or change/delete an existed template curve too. Any change or a new template curve entry actives with Post button.
When the form opens from File Menu as Template Curve Entry to enter new curves into template curves file, its appearance changes a little. Close and Help buttons take over by OK and Cancel buttons and colors of the grit and many others subjects become white color.
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This form like Pilot Screens opens as a child form of main form. So the treatments such as minimize, maximize horizontal/vertical tile that applies to Pilot Screens are also valid for it.
5.3. All Properties Form
With 3DMath Explorer, we pilot graphs in an object driven space. All properties of this space can be change with All Properties Form. This form opens by selecting All Properties in Display Menu, or pressing [image: image9.png]&



 button on Standard Toolbar, or by All Properties command in the menu that opens with right mouse click on Pilot Screen. But the easiest way to open this form is double click on Pilot Screen and the form pops up on to computer screen.   
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In this form, properties of Pilot Screen are grouped in four divisions.

In General Tab, background color, fogging and its density, perspective and horizon point of perspective, little axis’s visibility and its color can be change and all properties in this form can be made default screen properties, or default properties that set before can be load.
In Axis’s and Grids Tabs, display properties of axis and grid plot elements can be change. Axis numbers visibility can be change on and off or Grids can be cover with polygons.
In Animation Tab pilot can be animate by open Auto Rotate property and Timer Interval of Auto Rotation can be select.
5.4. Toolbars
3DMath Explorer has two toolbars named as View Toolbar and Standard Toolbar. By using toolbars, user almost can do every thing without going up to any menu.

Visibility of toolbars can change with Toolbars submenu in View Menu or with menu that opens by right mouse click on an empty space by side of them. 
Except these two toolbars, a third bar exists in the program. This is Status Bar and it displays short information about operations to guide users. But you can hide this bar to get more vision space on your computer screen. To do this go View Menu and remove the thick before Status Bar command.
The visibilities of these bars save to an .ini file as view properties of program. Program read and applies these properties next time it opens.  
5.4.1. View Toolbar
Many properties of piloting screen can be change directly by using View Toolbar that you see in the picture below. 
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Now let’s take buttons and their tasks in order. The first six buttons change visibility of XY, XZ, YZ grids and x, y, z axis’s. The Num button changes axis’ numbers visibility. Next three buttons change draw types of all curves to polygons, lines and points at the same time. Next four buttons open or close fogging, perspective, Four View and Auto Rotate properties of pilot screen. The next four buttons that comes after this buttons set front, right, left and perspective view of graph. When you set the button with hand picture down, you can carry center of graph with mouse. On the other hand when you set the next button down you rotate the graph over x and y axis’ with mouse. The two buttons that comes next are zooms the graph to twice its current size or they zoom the graph to half its current size. To zoom the graph an exact size in numbers, all you have to write it down the next area in this toolbar or select a value from its drop down list. You can open Zoom form by double click in this area and select a zoom size by using this form too.
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	This form opens  with Custom in Zoom Menu or by double click on zoom combo box in view toolbar or by Zoom command in the menu that opens with right mouse click on Pilot Screen


5.4.2. Standard Toolbar
Many buttons in Standard Toolbar almost exist in all applications as a standard. So we don’t need to mention all about them. So we take only some of them, and tell their tasks. 
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 button opens a new pilot window/screen  that has only default piloting elements that wants to visible 
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 button opens files with ’.tec’ extension to show and work on in a new graphing window/screen.
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 button uses to save graph in active window as technical file format (with ’.tec’ extension) or the simple picture format file (with ‘.bmp’ extension).
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 button prints out graph in active window.
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 button copies the graph in active window as a bitmap picture and puts it on the clipboard so that you can paste this picture to any word or picture editing program.
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 button shows or hides Curved Explorer tool window.
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 button shows or hides Operator Select tool window.
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 button shows or hides View Toolbar.
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 button opens Vertex Values form to see coordinate values of vertexes that used to draw graph in active window 
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 button opens All Properties form to change properties of active windows.

[image: image27.bmp] button opens a simple calculator program named Function Calculator to calculate functions.
5.5. Operator Select Tool Window
Now let’s mention about the two forms that named above.  First of them is Operator Select Tool Window, and it is a tool that make easy to enter the functions that given by users as parameters of curves. With help of this tool, operators, parenthesis, functions, numbers and constants can be entered more quickly. 
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	+
	Addition

	
	-
	Subtraction

	
	*
	Multiplication

	
	 /
	Real Division

	
	\,div
	Integer Division

	
	%,mod
	Remainder

	
	^
	Power

	
	!
	Calculate the N!**

	
	=
	Assignment

	
	Not
	Boolean NOT

	
	And 
	Boolean AND

	
	Or
	Boolean OR

	
	Xor
	Boolean XOR

	
	==,eq
	Equal

	
	!=,neq
	Not Equal

	
	<,lt
	Less-Than 

	
	>,gt
	Greater-Than

	
	<=,le
	Less-Than-or-Equal-To

	
	>=,ge
	Greater-Than-or-Equal-To

	
	(,),[,]
	Left-Right Parenthesis 

	
	[|,|]
	Absolute Value Left-Right Parenthesis

	
	pi
	Constant (() Pi 3,14159265358979..

	
	e
	Constant 2,71828182845905.......

	
	true
	Constant 1

	
	false
	Constant 0

	Cos
	Cosine function
	Sin
	Sine function

	Arccos
	Inverse cosine function**
	Arcsin
	Inverse Sine function**

	Cosh
	Hyperbolic cosine function** 
	Sinh
	Inverse Sine Hyperbolic function**

	Arccosh
	Inverse cosine Hyperbolic function 
	Arcsinh
	Inverse Sine function Hyperbolic **

	Tan
	Tangents function** 
	Cotan
	Cotangents function**

	Arctan
	Inverse Tangents function** 
	Arccot
	Inverse Cotangents function**

	Tanh
	Hyperbolic Tangents function**
	Coth
	Hyperbolic Cotangents function**

	Arctanh
	InverseTangentsHyperbolic function 
	ArcCoth
	Inverse Cotangents Hyperbolic function 

	Sec
	Sekant function** 
	Cosec
	Cosecant function**

	Arcsec
	Inverse Secant function** 
	Arccosec
	Cosecant function**

	Sech
	Hyperbolic Secants function**
	Cosech
	Hyperbolic Cosecants function**

	Arcsech
	Inverse Secants Hyperbolic function
	Arccosech
	Inverse Cosecants Hyperbolic function

	Ln
	Natural logarithm function** 
	Abs
	Absolute Value**

	Log
	Logarithm function (base 10) 
	Sgn
	Signum of a number**

	Log2
	Logarithm function (base 2) 
	Heav
	Greater than1.0 function**

	Ph
	Ph function** 
	Zero
	Zero function**

	Ceil
	Ceil  function** 
	Floor
	Floor function**

	Round
	Closest Integer Value function** 
	İnt
	Integer Part of a real number**

	Fact
	Factorial (Calculate the N!) function 
	Exp
	Exponent (e^)  function**

	Sqr
	Square** 
	Sqrt
	Square Root**


**The functions that banned in limited trial version 
This form is also important to show functions, constants and operators that can be use in 3DMath Explorer. In this form, as you see, same buttons are disabled. These are functions and operators that you can’t use even you write them manually in trial version. This is the only limitation for trial version. 
5.6. Vertex Values Form
The second form that named above is Vertex Values Form. This form lets you see coordinates of vertexes that belongs to curves and used to pilot them, with functional properties of curves. With the aid of navigation buttons, you can move over curves. The form shows sum of lines length and (if exist) sum of surface area of curves too. 
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This form opens up in many ways. For example it can be open by Vertex Values in Tools Menu or by click on [image: image30.png]Num,



 button on Standard Toolbar or selecting Vertex Values in right mouse menu that opens on Pilot Screens.
5.7. Looks Form
Looks Form enables you more efficiently select a view. Select one of tree main view or write rotation angles of x and y axis’s, and click OK. This form opens by selecting other in Looks Menu or by Look command in the menu that opens with right mouse click on Pilot Screen.
[image: image31.png]View

© Front L ’/NQK |
© Top ® Cancel
 Right

#ois Patations





Instead of this form, you can get any view of pilot by mouse. Just press right mouse button and hold it, rotate the graph on x and y axis’s by mouse movements, and release the button when the graph comes to the rotation that you want to get.
5.8. Zooming Form
Although we already mentioned about this form when telling buttons task in View Toolbar, we have to take it again in this topic. Zooming form enables you select more efficiently a zoom rate. Select a zoom rate or write a zoom percentage, and click OK. This form opens by Custom command in Zoom Menu or by double clicks on zoom combo box in View Toolbar or by Zoom command in the menu that opens with right mouse click on Pilot Screen.
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Of course zoom value of Graph can change much easily with zoom in and zoom out buttons or zoom field in view toolbar.

5.9. Wall Paper Properties Form
Our last form is Wall Paper Properties Form that opens by selecting Wall Paper in View Menu or by double clicks on main form wall paper. With this form main form wallpaper properties can change. After choosing the file that will be used for wall paper and its display pattern, new properties would set up by pressing OK button. 
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5.10. Function Calculator
Function Calculator is a simple calculator program that calculates mathematical expressions. In 3DMath Explorer you can externally run this program as an additional tool. You can also use this program alone as a simple and very useful calculator. Write your mathematical expressions and values of variants that are needed for calculation, and click Calculate or press Enter. The result will be generate and appear in result box. 
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In this version of Function Calculator, there is almost everything which you want to be in a good calculator. In fact with a little development, it easily could be the best calculator of its kind.

We keep on developing this program alone. So in the future you will very likely find it as a single program. On the other hand we will continue to add new versions of this program to next versions of 3DMath Explorer. 
There is no limitation in Function Calculator. It is fully functional. You can use it with in and after trial period, and if you wish, you can keep it in your computer and continue to use it after this period completed. 
5. TUTORIAL - Step by Step Piloting Curves with 3DMath Explorer
3DMath Explorer draws three dimensional (3D) graphs. But curve dimensions change with number of defined loop variables. So in this tutorial, in the first place we grouped curves with their dimensions as one dimensional (1D) curves, two dimensional (2D) curves and three dimensional (3D) curves. 

Now we take them one by one and tell how we draw these curves’ graphs with 3DMath Explorer. But please do remember 3DMath Explorer draws three dimensional (3D) graphs, and this don’t change with dimension of curves, 3DMath Explorer draws all kind of curves in the same 3D mathematical space.
6.1. Piloting Graphs of One Dimensional (1D) Curves
In 3DMath Explorer, curves defines with 3 functions one for each 3 axis’s. For example to draw a simple function curve like y=2*x+4, blow definitions must be done.
fx= x

fy= 2*x+4
fz= 0              (=> in reality fz= 0*x=0 )
As you see x is the variable for three axis functions. So to draw this curve variable x must be defined as a loop variable with start, stop and step values.
-8≤x≤8   ,  Xstep =0.1
fx(x) = x
fy(x) = 2*x+4
fz(x) = 0
Now let’s enter these curves into curve explorer. As a result of this we get below graph.
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6.2. Piloting Graphs of Two Dimensional (2D) Curves
Now let’s take a two dimensional (2D) curve and change same properties of it, and see how they would effect the graph (or what graphs we would get).
Sphere is a two dimensional curve. So it needs two loop variables that are valid for three axises to draw.

0≤a≤Pi      ,  a(step)=Pi/10

0≤b≤2*Pi  ,  b(step)=Pi/10

fx(a,b) = 5*sin(a)*cos(b)

fy(a,b) = 5*cos(a)

fz(a,b) = 5*sin(a)*sin(b)
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When we chose the curve’s draw type as lines and its line withy as 8 on the curve explorer, we gets the below graph.
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In the below, you see the same curve on a different background color after changing its line withy as 1 and its brush color as Lime.
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Now let’s change start value of loop variable b from 0 to Pi/5 and rotate the graph a little by mouse.

Pi/5≤b≤2*Pi  ,  b(step)=Pi/10

[image: image41.png]iy





Let’s remove fogging effect.
[image: image42.png]Demo.




Now we activate fogging effect but remove perspective effect,
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We again activate perspective effect and make visible yz-grid that covered with polygons 
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6.3. Piloting Graphs of Tree Dimensional (3D) Curves
Now let’s give a third dimension to a 2D sphere,
    0≤a≤Pi       ,  a(step)=Pi/10

Pi/5≤b≤2*Pi  ,  b(step)=Pi/10

fx(a,b) = 5*sin(a)*cos(b)

fy(a,b) = 5*cos(a)

fz(a,b) = 5*sin(a)*sin(b)

The constant 5 in the parameters of this curve is radius (r) of it. So we can change these expressions as below;
    0≤a≤Pi       ,  a(step)=Pi/10

Pi/5≤b≤2*Pi  ,  b(step)=Pi/10

    r = 5  (or 5≤r≤5   ,  r(step)=0)

fx(a,b,r) = r*sin(a)*cos(b)

fy(a,b,r) = r*cos(a)

fz(a,b,r) = r*sin(a)*sin(b)

Finally we have to define a new loop variable for third dimension. Now let’s define r as third dimension variable. We made this variable r a loop variable with start value 4, end value 5 and step value 1, and we change step values of a and b with value 0.3.
    0≤a≤Pi        ,  a(step)=0.3

Pi/5≤b≤2*Pi   ,  b(step)=0.3

    4≤r≤5         ,  r(step)=1

fx(a,b,r) = r*sin(a)*cos(b)

fy(a,b,r) = r*cos(a)

fz(a,b,r) = r*sin(a)*sin(b)
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6.4. Approaching to Curves / Zooming of Graphs
In reality, zooming of graphs mains looking them from a near position. Looking point is closely related with horizon point. When horizon point is selected as (0,0,z) and Z=-500, we are looking to the graph from coordinate at (0,0,z) and Z=+500. But in %100 zoom view, we want 1 unit vertical distance to draw with 20 pixel. So this make us look to graph not from Z=500 but Z=25 (because 500/20 = 25) when %100 zoom view is selected. As a result when %200 zoom view selected, our looking point came at coordinate (0,0,12.5), and when %400 zoom view selected, its goes to coordinate (0,0,6.25).
When perspective property of graph is on and the distance between our view point and graph origin is less than sphere’s radius, we would look and get view of graph from inside of the sphere towards to outside of it.
In the below we are looking at a graph from coordinate at (0, 0, 4) with %600 zoom. But this coordinate exists in a 3D sphere. This make us get a view of graph from inside of this 3D sphere. So we can see inside of this 3D sphere and  an other sphere that stays outside of this sphere.
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Now let’s see striped view of the graph instead of the polygon view.
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As you see, working on with 3DMath Explorer is such an easy. In the course of time, you get use to 3D math environment and will learn many more. But from now on, it depends on you. 
I hope you enjoy yourself with 3DMath Explorer and I wish It would spend you many amusing hours before your computer.
Dursun TEBER
e-mail:  dursun@teber.biz        
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